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1. Analysis Systems 

Quintic allows the user to analyse up to 21 different videos within our Multi Video 

analysis option. The data from these videos are calculated for you and can be viewed 

in graphical form by pressing either the Linear Analysis   or the Angular Analysis  

 buttons.  

From this you can then select Single Video Analysis or Multi Video Analysis.  

Linear Analysis    

Click on the Linear Analysis button, then either select ‘Single Video Linear Analysis’ 

(this is covered in Tutorial 8B) or ‘Multi Video Linear Analysis’.  

 

 

 

Linear analysis will provide data on the Distance, Velocity and Acceleration of the points 

that have digitised.  

Angular Analysis 

Click on the Angular Analysis button, then either select ‘Single Video Angular 

Analysis’ (this is covered in Tutorial 8B) or ‘Multi Video Angular Analysis’.   

 

 

 

 

Angular Analysis will provide data on Angular Displacement, Angular Velocity and 

Angular Acceleration of the points that have been digitised.  

 

 

 

 



2. Folder Setup 

Multi trial analysis allows you to display the data from multiple trials on the same graph. 

In order to complete this analysis, all of the relevant files for each trial must be placed in 

the same folder (up to 21 different trials). 

Video file (AVI in picture below) – The video file format must be one that is compatible with 

Quintic. At least one of the trials must have the original corresponding video file, in order to 

open the video and begin analysis. 

CAL – The CAL file contains the information of the known length used to calibrate the 

corresponding video file. All calibration files must be present with the corresponding video 

file and related QDF. It is recommended that each video trial also has the same frames per 

second.  

QDF – The QDF file contains the coordinates of the raw digitisation trace for a given video. 

The QDF of each trial is required. 

QBC – The QBC file contains the parameters of the Butterworth filter applied to the 

digitised trace. This file isn’t necessary as it is possible to analyse raw data. However, if 

you wish to analyse smoothed data, every QDF file must have a corresponding QBC file. 

You cannot analyse data with a mix of raw and smoothed data. If smoothed data series 

are used, the same smoothing parameters do not have to be applied for all trials. 

MRK – The MRK file is the location of up to 10 frame markers placed on the video within 

Quintic. These files aren’t essential when analysing data, however, can be used to 

synchronise video traces to a common time event. If you wish to synchronise the videos 

relative to a common marker then all MRK files must be present and correspond to a QDF 

file. 

Below is an example of the files (highlighted) required to complete multi-trial video analysis 

with traces synchronised to a common frame marker. Analysis can be completed with a 

folder containing extra files, such as the video files for each trial shown above. However, 

this is not essential. 

If you wish to compare one average against another (eg. that of the right fore leg during 

equine analysis) then add the relevant files for each trial to the same folder as above. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A folder containing all the files necessary for multi linear/angular analysis of the left fore leg 

of a horse during equine gait analysis. 



3. Multi Video Linear Analysis 

Once all the videos have been digitised and the folder has been set up correctly, you 

are able to perform a Multi Video Linear Analysis. Simply open a video from your Multi 

Video Analysis folder and load the digitisation trace. Then click on the ‘Multi Video 

Linear Analysis’ option after the Linear Analysis button has been pressed.  

If the digitisation trace has not been loaded on the video, the following pop up will 

appear, asking you to load the digitisation trace, please click ‘Yes’.  

 

 

 

 

Once the digitisation trace is loaded and the ‘Multi Video Linear Analysis’ button has 

been pressed, the Multi Video Linear analysis window will load.  

This will display the Distance, Velocity and Acceleration in 3 different graphs, for all the 

videos within the folder, which have been set up correctly within the multi-video analysis 

folder.   

If there are any Time Event Markers (please see Tutorial 2 for further information) that 

have been saved with the videos, they will also be displayed onto all 3 graphs. This will 

allow the user to quickly identify on the graph the key events of interest to them (i.e 

Impact, Low Point, Toe Off etc) and the data to be synchronised to these common time 

events. The Time Event Markers will be displayed on the graphs by a blue line, with the 

default name of Marker 1, Marker 2 (if the Time Event Markers have not been named) 

or the relevant name of that marker if they have been named. The time event markers 

displayed are only relating to the associated video which is open within the Quintic 

Window (unless synchronised to a marker and then that one marker is true for all videos 

within the Multi analysis).  

Any Interpolation Markers that have been added to the digitisation trace and saved, will 

also be shown on the graphs. These are shown with a burgundy line on the graphs.  

Please see below an example of the Multi Video Linear Analysis Window within Quintic 

Biomechanics v35 software.  



 

 

 

 

 

 

  

  

 

 

 

 

 

 

 

 

 

Highlights the different 

video trials which are 

displayed on the graphs. 

Each trial has its own 

colour. The user is able 

to select and deselect 

which trials are 

displayed on the graphs. 

Users are also able to 

opposite the horizontal 

direction of the trace.  

 
Select linear, horizontal 

or vertical values by 

ticking the relevant box. 

These values will then 

also be displayed on the 

corresponding graphs.  

 

Digitisation Trace 

Information. Please see 

below for further 

information 

 

Data Series Type – Either 

smoothed or raw data. In 

this example smoothing 

parameters have been 

applied to the traces.  

Moving Average – This displays 

the moving average that is 

applied to the data. Please see 

the heading “Moving Average” 

below for more information.   

Select which marker to 

display from the menu. 

This corresponds to the 

amount of points in the 

digitisation trace. 

Live Data Table – This button will pop open 

the Live Data table, which allows the user to 

easily identify data values at specific points of 

interest, throughout the video. Please see the 

heading Live Data Table for more information.  

 

Select All – When pressed, 

this will show all of the digitised 

traces on all the graphs.  

 

Deselect All – When 

pressed, this will hide all 

of the digitised traces 

on all the graphs.  

 

Trial Details – This button will pop open the 

details of the trials included within the analysis. 

Details include: Frames per second of the 

videos, whether smoothing has been applied 

and number of frame markers.  

 



 

 

 

When Show Averages is unticked: 

 

When Show Averages is ticked:  

 

When the show averages option is ticked, all of the other buttons related to the average will also 

become active.  

These are as follows: 

 

 

 

 

 

 

 

This allows the user to create an average 

from the video trials which are displayed. 

The user is able to display one, two and/or 

the normative average on the graph.  



Avg Only  

This will display the average only on the three graphs (Distance, Velocity and Acceleration). If 

you have more than one average displayed (i.e 2nd/normative) this will also display the average 

only of these averages.  

 

Data  

This will display the average as well as all of the individual data traces on the three graphs 

(Distance, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and data traces for these averages. The 

associated data traces are appropriate colour to the average they are in i.e Red/Blue.  

 



95% CI  

This will display the average as well as the 95% confidence intervals on the three graphs 

(Distance, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and 95% confidence intervals for these 

averages.  

 

95% PI   

This will display the average as well as all of the 95% prediction intervals on the three graphs 

(Distance, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and 95% prediction intervals for these averages. 



Both the video in the main window and multi - analysis windows are synchronised, therefore if 

the video is played while the separate analysis window is open, a black line indicates the 

current video frame. 

 

 

 

The video which is synchronised with the analysis window will be displayed in bold where the video 

files are listed.  

Each graph can be expanded to the size of the analysis window by double clicking on the relevant 

pane. 

Alternatively, to zoom in on a specific area of the graph drag the cursor over the area you wish to 

zoom in on. The graph will resize and rescale in order to fill the graph area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



a. Functions 

Within the Multi Video Linear Analysis window there are a range of functions which the user is 

able to change, which directly affect the distance, velocity and acceleration graphs.  

The functions are available at the top of the Multi Video Linear Analysis Window and are as 

follows: 

 

b. File  

Within the File menu, the user is able to Print, Print Preview, Save as JPEG or Copy to 

Clipboard the individual Distance, Velocity and Acceleration graphs. The user is also able to 

Print, Save as JPEG or Copy to Clipboard the Distance, Velocity and Acceleration Graphs with 

or without the side bar as one image.   

 

 

 

 

 

c. Units 

Within the Units menu, the user can change the units for the Distance and Speed/Acceleration 

graphs. The Distance options are Metres or Feet. The Speed/Acceleration options are as 

follows: Metres/Second, Kilometres per hour, Feet/Second or Miles per hour. 

 

 

 

 

 

 



d. Frames/Page 

Within the Frames/Page menu, the user is able to select how many frames are displayed on the 

graphs within the analysis window. This is ideal for users who have long digitisation traces. 

 

 

 

 

 

 

As default, the analysis windows will display all of the points on the graphs. Should users want 

to change this, they are able to do this by going to the Help tab within the main Quintic software. 

To do this, click the ‘Help’ button, then Settings, Analysis Defaults, Frames/Page and then 

select your preferred option. This will apply to all analysis windows.  

 

 

 

 

 

 

 

 

 

 

 

 

 



e. Display 

Within the Display menu, the user is able to able to adjust certain display settings which affect 

the Distance, Velocity and Acceleration graphs.  

 

 

 

 

 

 

 

 

 

 

 

Show Frame Position – Ticking and Unticking the Show Frame Position (Default – Ticked/On) 

will show and hide the black line which appears to highlight the current frame position in relation 

to the current frame in the video. Current frame position for the video that is bold within the multi 

analysis window. 

Show Frame Position ON: 

 

 

 

 

 

 

 

 

 



Show Interpolation Markers – Ticking and Unticking the Show Interpolation Markers (Default – 

Ticked/On) will show and hide any Interpolation markers which are saved onto the associated 

digitisation trace. They will be shown on the graph by a burgundy line(s). Interpolation markers 

displayed are in relation to the video that is bold within the multi-analysis window.  

Show Interpolation Markers ON:  

 

 

 

 

 

 

 

 

 

Show Frame Markers – Ticking and Unticking the Show Frame Markers (Default – Ticked/On) 

will show and hide any frame (Key Event) markers if there are any saved and within the 

digitisation range. They will be shown on the graph by blue line(s) and will either say Marker 1, 

Marker 2 etc if they have not been named or the relevant names if they have been named. The 

time event markers displayed are in relation to the video that is bold within the multi analysis 

window.  

Show Frame Markers ON: 



Show Interpolated Regions (Intelligent) – Ticking and Unticking the Show Interpolated 

Regions (Intelligent) will show and hide any regions where the reflective markers were lost or 

occluded and the marker(s) are interpolated within that region. When analysing trial data in 

Quintic, the regions where interpolation has occurred are shown using different colours of box 

and hatching: 

Solid Grey Box – This occurs when the whole reference template has been lost from the Area of 

Interest (AOI). The solid grey box appears on the graph between the frame where the template 

was completely lost and the frame where the whole template was re-found. The data series in 

this region is obscured from view. 

 

Coloured Hatching – Covers the region of the graph where a single marker has been lost. The 

colour of the box is dependent on the colour of the marker selected when creating the reference 

model.  

Interpolated Regions ON: 

 

 

 

 

 

 

 

 

When using Multi Angular Analysis hatching will only be displayed when the selected angle 

includes the marker that has been interpolated. E.g. When analysing the knee angular velocity 

during a gait analysis, regions where the hip marker has been interpolated, the hatchings will be 

displayed. 

However, in order to show interpolated regions, all videos must be digitised using the Intelligent 

Digitisation function in Quintic Coaching or Biomechanics v29/v31/v33/v35. 



Minimums – The user is able to identify the minimum point on the Distance, Velocity and 

Acceleration graphs. Options are Min, Min and Value and Min, X Pos and Value.  

Min – This will draw a small notch for each individual point at the minimum position for distance, 

velocity and acceleration.  

 

 

 

 

 

 

 

Min and Value – This will draw a small notch and give the minimum value at the minimum 

position for distance, velocity and acceleration.  

 

 

 

 

 

 

Min, X Pos and Value – This will draw a small notch, give the X position (whether this be time or 

frame number) and the minimum value at the minimum position for distance, velocity and 

acceleration.  

 

 

 

 

 

 

 



Maximums – The user is able to identify the maximum point on the Distance, Velocity and 

Acceleration graphs. Options are Max, Max and Value and Max, X Pos and Value.  

Max – This will draw a small notch for each individual point at the maximum position for 

distance, velocity and acceleration.  

 

 

 

 

 

 

Max and Value – This will draw a small notch and give the maximum value at the maximum 

position for distance, velocity and acceleration.  

 

 

 

 

 

 

Max, X Pos and Value – This will draw a small notch, give the X position (whether this be time 

or frame number) and the maximum value at the maximum position for distance, velocity and 

acceleration.  

 

 

 

 

 

 

 



Horizontal Axes – This allows the user to edit the horizontal axes on the Distance, Velocity and 

Acceleration graphs. The options available to the user are: Relative Frame Number, Relative 

Time, Relative Frame Number (Marker) and Relative Time (Marker).  

 

 

 

 

Relative Frame Number – The horizontal axis will start from 1, with 1 being the start of the 

digitisation trace as it is relative to the first digitised frame for each video within the multi-trial 

analysis, regardless of length of the trace or time event in the video. The end of the traces are 

subsequently cut to the shortest trace, to be displayed on the graphs. 

Relative Time – The horizontal axis will start from 0, with 0 being the start of the digitisation 

trace as it is relative to the first digitised frame for each video within the multi-trial analysis. The 

end of the traces are subsequently cut to the shortest trace, to be displayed on the graphs. 

Relative Frame Number (Marker) – This allows the user to change the 0 point of the graph to a 

Marker (Key Event) of their choice, if all the videos within the multi-trial analysis have markers 

set. Graph data series are aligned to eg. Frame marker 1 (eg. first fore leg contact) and trimmed 

to the shortest digitisation trace. The x axis displays the common marker as 0. Both ends of the 

traces are trimmed to the shortest trace, to be displayed on the graph. The markers have to be 

in the same order to be synchronised effectively. 

Relative Time (Marker) - This allows the user to change the 0 point of the graph to a Marker 

(Key Event) of their choice, if all the videos within the multi-trial analysis have markers set. This 

allows all the videos within the multi-trial analysis to be synchronised to a marker (e.g toe off, 

contact, impact etc). The x axis is displayed as time relative to the marker (0). Both ends of the 

traces are trimmed to the shortest trace, to be displayed on the graph. The markers have to be 

in the same order to be synchronised effectively. 

 

 

 

 

 



Vertical Axes – This will allow the user to adjust the Vertical Axes of the Distance, Velocity and 

Acceleration graphs independently. As default, Quintic will automatically scale the Vertical Axis 

to the best possible fit, so that both the minimum and maximum values are displayed in each 

graph.  

 

 

 

 

 

 

 

Users are able to manually adjust the Vertical Axes, by unticking the ‘Automatically Scale 

Vertical Axis’ for the graph they would like to manually scale, whether this be Distance, Velocity 

or Acceleration. Then simply enter in the Minimum and Maximum values you would like the 

vertical axis to display. You should notice the graph being updated live. Once you have set the 

vertical axes, simply close the Vertical Axes Settings Window. 

Second Average – The user is able to turn on the second average function which allows a 

second average to be displayed on the Distance, Velocity and Acceleration graphs. This will 

add a blue average column next to the red average column for each trial. Select the trials you 

wish to display as an average for each condition 

 

 

 

 

Click “Show Averages” and this will display the Red and Blue average.  

 

 

 

 

 



Normative Average – Please see below under the heading ‘Normative Average’ for more 

information on this feature.  

Show Similarity – Please see below under the heading ‘Similarity Value’ for more information 

on this feature.  

Raw/Smoothed – This allows the user to display either the Raw or Smoothed data (if all the 

videos within the multi-trial analysis have smoothing filters applied) for the distance, velocity and 

acceleration graphs. 

Moving Average – As default, a moving average is applied to the digitised data. This will be a 

moving average of 5 i.e the average of 2 frames previous to your current frame, your current 

frame and 2 frames after your current frame. This applies to all of the distance, velocity and 

acceleration graphs. The user is able to control how many frames should be taken into account 

for the moving average (3, 5, 7, 9, 11) or turn the moving average off completely (1).  

Linear Spline – As default, a Linear spline is applied to the digitised data, in order for this to 

appear smoother. The user has the ability to turn this linear spline on or off by either selecting or 

deselecting this option within the analysis window.  

Velocity and Acceleration – This allows the user to edit the way velocity and acceleration is 

calculated, this can either be one frame before or one frame before and one after.  

Show First/Last 6 Frames – This controls whether the first 6 and last 6 digitised frames are 

displayed within the analysis windows. As default, Quintic will not display these frames due to 

any potential smoothing filters applied to the data which may skew these points. The user is 

able to control whether this should be on or off. 

 

 

 

 

 

 

 

 

 

 



f. Origin  

Within the Origin Menu, the user is able to change the origin of the data. The origin options are 

either: Relative (from either the start point of the marker) or Absolute (the 0,0 coordinate). As 

default the Quintic analysis windows will be set to relative. If the user has a Custom Origin set, 

the user should select Absolute, which will use your Custom origin as the 0,0 coordinate. 

 

 

 

g. Save Results  

Within the Save Results menu, the user is able to save the results which are displayed on the 

Distance, Velocity and Acceleration graphs into an excel document for further analysis.  

 

 

 

 

 

Users have the option to: 

Save Results in Excel File – Saves whatever points is displayed on the distance, velocity and 

acceleration graphs for each of the video trials selected.  

If averages are calculated, a separate excel will be created for these. Within the Average Excel, 

it states which trials are included within the average. 

Save Results in Excel File (Co-Ordinates Only) – Saves the co-ordinates of the point only for 

each of the video trials selected. The user is then able to calculate the distance, velocity and 

acceleration manually.  

With both options, users can either save the excel as an .xls (97-2003) or an .xlsx (2007 +). 

Once Save Results in Excel File has been selected, users will have to choose the file name and 

location where they would like the excel files to be created.  

 

 

 



h. Settings 

Within the Settings menu, the user is able to choose their preferred settings for ‘Use Focus 

Region (Saving/Min/Max)’ or ‘Multi Linear Analysis Defaults’. 

Use Focus Region (Saving/Min/Max) - Users can also choose to save all the data on the graph 

or a particular region of the graph. They are able to do this by going to Settings, then ‘Use 

Focus Region (Saving/Min/Max)’. 

 

 

 

When the ‘Use Focus Region (Saving/Min/Max)’ is activated, the focus region will show on the 

graphs in Gold vertical lines.  

Users can control the save region by using the Focus Region sliders on the right-hand side of 

the Single Linear Analysis Window.  

 

 

 

To use the particular region you have selected, click ‘Use Save Region’ and when you save 

results as an Excel (by going to the Save Results tab), only the points within the saved region 

will be saved to the Excel.  

The Focus Region also effects the Min and Maxs. If the focus region is in use, and Min/Max are 

also in use, only the Min/Max within the Focus Region will be displayed on the graphs. 



Multi Linear Analysis Defaults – This gives the user the option to set their default analysis 

window settings. Every time you open the Multi Linear Analysis window, your preferred analysis 

settings will be remembered and used. 

 

 

 

Once you are happy with the settings that you have chosen, go to the settings option within the 

analysis window. Then select ‘Multi Linear Analysis Defaults’ then ‘Set Current Choices As 

Defaults’ and this will remember your preferred settings. 

 

 

An information window will pop up to confirm that the defaults have been set.  

 

 

 

 

 

 

In order for the software to load your default analysis settings, please select ‘Load Analysis 

Using Defaults’ for the Multi Linear Analysis Window. You would have to do this for each of the 

analysis windows (Single Linear, Single Angular, Multi Linear and Multi Angular).  

 

 

 

Please see below for more information on what will be remembered in the Multi Linear Analysis 

window: 

• Template Point Names (to check that when Multi Linear is next loaded, it is the correct 
template) 

• Assuming template matches default template, it also reloads whichever linear point was 
previously selected – i.e. if you had selected Knee within Multi Linear, it would reload with 
Knee, assuming the templates all matched the default 

• Linear/Horizontal/Vertical choice 

• Whether you have expanded a graph 

• Which your preferred Unit is in the Units drop-down 

• Your display preferences (specifically: Show Series Values, Show Interpolation Markers, 
Show Frame Position, Show Frame Markers, Show Interpolated Regions) 

• Min/Max display choices 

• Whether second average is on 

• Whether similarity is on 

• Origin drop-down choice 
 
 



4. Multi Video Angular Analysis 

Once all the videos have been digitised and the folder has been set up correctly, you 

are able to perform a Multi Video Angular Analysis. Simply open a video from your Multi 

Video Analysis folder and load the digitisation trace. Then click on the ‘Multi Video 

Angular Analysis’ option after the Linear Analysis button has been pressed.  

If the digitisation trace has not been loaded on the video, the following pop up will 

appear, asking you to load the digitisation trace, please click ‘Yes’.  

 

 

 

 

 

Once the digitisation trace is loaded and the ‘Multi Video Angular Analysis’ button 

has been pressed, the Multi Video Angular analysis window will load.  

This will display the Displacement, Velocity and Acceleration in 3 different graphs, for all 

the videos within the folder, which have been set up correctly within the multi-video 

analysis folder.   

If there are any Time Event Markers (please see Tutorial 2 for further information) that 

have been saved with the videos, they will also be displayed onto all 3 graphs. This will 

allow the user to quickly identify on the graph the key events of interest to them (i.e 

Impact, Low Point, Toe Off etc) and the data to be synchronised to these common time 

events. The Time Event Markers will be displayed on the graphs by a blue line, with the 

default name of Marker 1, Marker 2 (if the Time Event Markers have not been named) 

or the relevant name of that marker if they have been named. The time event markers 

displayed are only relating to the associated video which is open within the Quintic 

Window (unless synchronised to a marker and then that one marker is true for all videos 

within the Multi analysis).  

Any Interpolation Markers that have been added to the digitisation trace and saved, will 

also be shown on the graphs. These are shown with a burgundy line on the graphs.  



Please see below an example of the Multi Video Angular Analysis Window within 

Quintic Biomechanics v35 software.  

 

 

Both the video within the main window and analysis windows are synchronised, therefore if the 

video is played while the separate analysis window is open a black line indicates the current video 

frame. The video which is synchronised with the analysis window will be displayed in bold where 

the video files are listed.  

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each graph can be expanded to the size of the analysis window by double clicking on the relevant 

pane. 

Alternatively, to zoom in on a specific area of the graph drag the cursor over the area you wish to 

zoom in on. The graph will resize and rescale in order to fill the graph area. 

 

 

Data Series Type – Either 

smoothed or raw data. In 

this example smoothing 

parameters have been 

applied to the traces.  

Lists the different video trials which are 

displayed on the graphs. Each trial has its own 

colour. The user is able to select and deselect 

which trials are displayed on the graphs. Users 

are also able to opposite the angle as well as 

flip the angle from negative to positive or vice 

versa. 

Digitisation Trace 

Information. Please see 

below for further 

information 

 

Select which angle to 

display from the menu. This 

corresponds to the amount 

of points in the digitisation 

trace. 

This allows the user to create an average 

from the video trials which are displayed. 

The user is able to display one, two and/or 

the normative average on the graph.  

Live Data Table – This button will pop open 

the Live Data table, which allows the user to 

easily identify data values at specific points 

of interest, throughout the video. Please see 

the heading Live Data Table below for more 

information.  

 

Select All – When 

pressed, this will show 

the angle selected from 

all of the digitised videos 

on the associated graphs.  

 

Deselect All – When 

pressed, this will 

deselect the angle from 

all of the digitised 

videos on the 

associated graphs.  

 

Moving Average – This displays 

the moving average that is 

applied to the data. Please see 

the heading moving average 

below for more information.   

Trial Details – This button will pop open the 

details of the trials included within the analysis. 

Details include: Frames per second of the 

videos, whether smoothing has been applied 

and number of frame markers.  

 



 

When Show Averages is unticked: 

 

When Show Averages is ticked:  

 

 

When the show averages option is ticked, all of the other buttons related to the average will also 

become active.  

These are as follows: 

 

 

 

 

 

 

 

 



Avg Only  

This will display the average only on the three graphs (Displacement, Velocity and 

Acceleration). If you have more than one average displayed (i.e 2nd/normative) this will also 

display the average only of these averages.  

 

Data  

This will display the average as well as all of the individual data traces on the three graphs 

(Displacement, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and data traces for these averages. The 

associated data traces are appropriate colour to the average they are in i.e Red/Blue. 

 



95% CI  

This will display the average as well as the 95% confidence intervals on the three graphs 

(Displacement, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and 95% confidence intervals for these 

averages.  

 

95% PI   

This will display the average as well as all of the 95% prediction intervals on the three graphs 

(Displacement, Velocity and Acceleration). If you have more than one average displayed (i.e 

2nd/normative) this will also display the average and 95% prediction intervals for these averages 

 



a. Functions 

Within the Multi Video Angular Analysis window there are a range of functions which the user is 

able to change, which directly affect the Angular displacement, velocity and acceleration 

graphs.  

The functions are available at the top of the Multi Video Angular Analysis Window and are as 

follows: 

 

b. File  

Within the File menu, the user is able to Print, Print Preview, Save as JPEG or Copy to 

Clipboard the individual Angular Displacement, Velocity and Acceleration graphs. The user is 

also able to Print, Save as JPEG or Copy to Clipboard the Angular Displacement, Velocity and 

Acceleration Graphs with or without the side bar as one image.   

 

 

 

 

 

c. Units 

Within the Units menu, the user is able to change the units for the data within the Angular 

Displacement, Velocity and Acceleration Graphs. The options are as follows: Degrees, Radians.  

 

 

 

 

 

 

 

 

 



d. Frames/Page 

Within the Frames/Page menu, the user is able to select how many frames are displayed on 

the graphs within the analysis window. This is ideal for users who have long digitisation 

traces. 

 

 

 

 

 

 

 

 

 

 

 

As default, the analysis windows will display all of the points on the graphs. Should users 

want to change this, they are able to do this by going to the Help tab within the main Quintic 

software. To do this, click the ‘Help’ button, then Settings, Analysis Defaults, Frames/Page 

and then select your preferred option. This will apply to all analysis windows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



e. Display 

Within the Display menu, the user is able to able to adjust certain display settings which affect 

the Angular Displacement, Velocity and Acceleration graphs.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

These have already been covered. 

Please see above under ‘Multi 

Video Linear Analysis’ for more 

information on these features. 

 



Opposite Angles – Opposite will display the opposite angle from the one currently being 

displayed. 

Flip Angle Sign – This will change the angle from positive to negative or vice versa. 

Flip AB/BC Lines – This will activate the Flip AB/BC Line options. Once this has been clicked, 

‘AB’ and ‘BC’ will appear as tick boxes next to the list of trials within the Multi Angular Analysis 

window. You can then choose to flip the AB or BC lines for the certain trials within your analysis, 

for the angle in question. 

Flip AB Line – This will allow the user to Flip AB Line for all of the trials within the Multi Angular 

Analysis Window. 

Flip BC Line - This will allow the user to Flip BC Line for all of the trials within the Multi Angular 

Analysis Window. 

Negative Angles – This allows negative angles to be displayed. As default, this setting is 

switched on. This is particularly useful when looking at an angle which fluctuates around 0.  

Horizontal – If an angle has been created using the horizontal, the user is able to choose 

whether the horizontal will be to the left or to the right. As Default this is set to the right.  

Vertical – If an angle has been created using the vertical, the user is able to choose whether 

the vertical will be to the top or bottom. As default this is set to the top.  

Second Average – The user is able to turn on the second average function which allows a 

second average to be displayed on the Displacement, Velocity and Acceleration graphs. This 

will add a blue average column next to the red average column for each trial. Select the trials 

you wish to display as an average for each condition 

 

 

Click “Show Averages” and this will display the Red and Blue 

average.  

 

 

 

 

 

 

 



Normative Average – Please see below under the heading ‘Normative Average’ for more 

information on this feature.  

Show Similarity – Please see below under the heading ‘Similarity Value’ for more information 

on this feature.  

 

f. Save Results  

Within the Save Results menu, the user is able to save the results which are displayed on the 

Angular Displacement, Velocity and Acceleration graphs into an excel document for further 

analysis.  

 

 

 

 

Users have the option to: 

Save Results in Excel File – Saves whatever angle is displayed on the angular displacement, 

velocity and acceleration graphs.  

If averages are calculated, a separate excel will be created for these. Within the Average Excel, 

it states which trials are included within the average. 

Save Results in Excel File (Angles Only) – Saves the angles only. The user is then able to 

calculate the angular velocity and acceleration manually.  

With both options, users can either save the excel as an .xls (97-2003) or an .xlsx (2007 +). 

Once you have chosen your preferred file type, simply choose where you would like the file to 

be saved and name it appropriately. 

 

 

 

 

 

 

 

 



g. Settings 

Within the Settings menu, the user is able to choose their preferred settings for ‘Use Focus 

Region (Saving/Min/Max)’ or ‘Multi  Angular Analysis Defaults’ 

 

 

 

Use Focus Region (Saving/Min/Max) – Users can choose to save all the data on the graph or a 

particular region of the graph. They are able to do this by going to Settings, then ‘Use Focus 

Region (Saving/Min/Max)’. 

 

 

 

When the ‘Use Focus Region (Saving/Min/Max)’ is activated, the save region will show on the 

graphs in Gold vertical lines.  

Users can control the save region by using the ‘Focus Region’ sliders on the right-hand side of 

the Multi Angular Analysis Window.  

 

 

 

 

 

To use the particular region you have selected, click ‘Use Focus Region (Saving/Min/Max)’ and 

when you save results as an Excel (by going to the Save Results tab), only the points within the 

saved region will be saved to the Excel. 

 



Multi Angular Analysis Defaults – This gives the user the option to set their default analysis 

window settings. Every time you open the Multi Angular Analysis window, your preferred 

analysis settings will be remembered and used. 

 

 

 

Once you are happy with the settings that you have chosen, go to the settings option within the 

analysis window. Then select ‘Set Current Choices As Defaults’ and this will remember your 

preferred settings. 

 

 

An information window will pop up to confirm that the defaults have been set.  

 

 

 

 

 

 

In order for the software to load your default analysis settings, please select ‘Load Analysis 

Using Defaults’ for the Multi Angular Analysis Window. You would have to do this for each of the 

analysis windows (Single Linear, Single Angular, Multi Linear and Multi Angular).  

 

 

 

Please see below for more information on what will be remembered in the Multi Angular 

Analysis window: 

• Template Point Names (to check that when Multi Angular is next loaded, it is the correct 
template) 

• Which angle you have selected angle to analyse, assuming template matches default 
template 

• Whether you have expanded a graph 

• Which your preferred Unit is in the Units drop-down 

• Your display preferences (specifically: Show Series Values, Show Interpolation Markers, 
Show Frame Position, Show Frame Markers, Show Interpolated Regions) 

• Min/Max display choices 

• Allow Negative Angles choice 

• Horizontal – Left/Right choice 

• Vertical – Up/Down choice 

• Whether second average is on 

• Whether similarity is on 
 
 



5. Live Data Table  

Within the Linear and Angular analysis windows, there is an option to display the live data table.  

 

 

To display the Live Data Table, simply click the Live Data button within the Linear or Angular 

analysis window.  

 

 

 

 

 

 

 

 

This will then display the data which is displayed on the Distance/Angular Displacement, 

Velocity and Acceleration graphs.  

As the video plays through, the Live Data table will be updated with the current frame data.  

Within the Analysis windows, if any points of the digitisation trace are unticked these will not be 

displayed in the Live Data Table. If Horizontal and Vertical (Linear Analysis only) are ticked on 

the graph, they will also be displayed on the Live Data Table.  

 

 

 

 

 

 

 

 



6. Normative Average 

The Normative Average function is a feature which is available within our Quintic Coaching v35 

and Quintic Biomechanics v35 software. This allows the user to create their own Normative 

Average of up to 100 digitised videos which can be displayed on the Linear/Angular graphs. The 

user creates their own normative average folder and selects this within the Multi Linear/Angular 

analysis window from which the average will be calculated and displayed.  

The user also has the ability to select Prediction Intervals/Confidence Intervals/Data and/or 

Average traces for each Average separately – i.e. 1st, 2nd, Normative (unable to display data).  

To create your own Normative Average Folder, the user must first create their own folder where 

the digitisation traces are to be added to.  

Once the digitisation process has been completed (can be Manual, Automatic or Intelligent) the 

user is then able to add the digitisation trace to the Normative Average folder in two ways this 

either ‘Through the Digitisation Menu’ (recommended) or ‘Manually’. 

Through the Digitisation Menu 

To add the completed digitisation trace to the normative average folder, click on the digitisation 

tab within the Digitisation menu.  

Click the Add Trace to Normative Average Folder 

 

 

 

 

 

 

 

 

 

 

 

 

 



This will add the Digitisation Trace and all of the associated files (except from the Video File) to 

this folder.  

Manually 

Users are also able to manually add their digitisation traces to the Normative Average Folder.  

The following files are required: 

Interpolation Markers .ent 

Frame Markers .mrk 

Rotation .rot 

FPS .fps 

Horizontal Calibration .hcal 

Vertical Calibration .vcal 

Calibration .cal 

Digitisation Trace .qdf 

Butterworth Smoothing .qbc 

Once you have added the digitisation traces to the normative average folder (up to 100 

digitisation traces) you then simply select the normative average folder within the Display Menu 

in either the Multi Linear/Angular window.  

 

 

 

 

 

 

 

 

 

 



Go to Display > Normative Average > Select Folder and select the normative data folder you 

have created. The normative data will then appear on the same graph when ‘Show Averages’ 

has been selected. 

 

N.B The same template must be used in both the Multi Trial videos and the Normative Average 

folder in order for the Normative Average to be loaded.  

Once the Normative Average folder has been selected, the user is able to turn the Normative 

Average On and Off by going to Display > Normative Average > Display.  

The user also has flexibility in how the Normative Average is displayed on the graphs.  

By clicking the button, the user is able to independently select whether the 

averages only are displayed, average and data (excluding normative) as well as the average 

and 95% CI or 95% PI.                                          

 

 

 

 

 

Please see the example below for the 95% Prediction Intervals compared against the Red 

Average.  

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



7. Similarity Value 

The similarity value calculates how similar the averages are in comparison with each other (1st, 

2nd, Normative) and gives a percentage. This is displayed between each pair of averages (i.e. 

1st and 2nd, 1st and Normative, 2nd and Normative). The similarity value will appear in the top 

left corner of the graph when the Show Averages button has been ticked within Multi 

Linear/Angular analysis. 

 

Users are able to turn the similarity value on/off by going to Display > Show Similarity.  

 

There is also the ability to select the range of the traces between which the Similarity is 

calculated (defaults at full trace). Users are able to do this by adjusting the Similarity 

boundaries. The left and right scrollbars will control the purple lines on the graph in which the 

similarity value is calculated.  

 

 

 

Users also have the ability to lock their similarity boundary by ticking the lock button. Users can 

then move their similarity region once this has been locked, just by moving one of the left or 

right scrollbars.  

 

 

 



 

The image above shows the similarity being calculated within the similarity region (in between 

the purple lines) rather than the whole graph. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



8. Trial Selection 

Multi – Trial Analysis (Linear & Angular) is limited to 21 trials.  

Should users have more than 21 available trials which are able to part of the Multi-Trial Analysis 

(Linear or Angular) from the folder in which the trials are opened from, the ‘Trial Selection’ will 

become active.  

A pop up will appear as soon as the user has clicked on Multi Linear/Angular Analysis stating 

that there are more than 21 trials available. In this case, the first 21 trials alphabetically will be 

selected.  

 

 

 

 

Following this, the Trial Selection window will appear.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clear All 

Selected Trials 

Display Trial – 

This will move 

any highlighted 

trials to the 

Selected Trials  

Displays the 

current trials 

which are 

selected. 

Displays the 

number of trials 

in the Selection. 

Maximum 21 

Trials. 

Hide Trial – 

This will move 

any highlighted 

trials to the 

Other Trials  

Displays the 

current trials 

which are not 

selected for 

analysis. 

Displays the 

folder name from 

which the trials 

are taken from. 

Displays the 

number of 

possible trials left 

in the folder.  



The user is then able to select which trials they would like to be included within the Multi-Video 

Analysis.  

To remove trials from the Selected Trials, simply highlight the trials from the Selected Trials 

section you would like to remove (you are able to move multiple trials in one go) and click the 

Hide Trial button.  

To add trials to the Selected trials, simply highlight the trials from the Other Trials section you 

would like to add (you are able to move multiple trials in one go) and click the Display Trial 

Button. Please bear in mind there is a maximum of 21 trials allowed to be selected at one time.  

Once the user is happy with the selected trials, simply close the Trial Selection Window and use 

the Multi-Trial analysis window as normal.  

Should the user the want to change trials whilst the Multi-Video analysis window is open, simply 

click the Trial Selection button.  

 

 

Please note that Trial Selection will only become active if the folder you are opening the Multi-

Trial analysis from has more than 21 possible trials.  

 


